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® ZOTH AL, ADCcontrol core only E—F THEINTLVET .

COEHTRENT S 32— 3vIE, A/D EROMEEFRIRMICIKRIIT 28D TIEHYFEE A LHL.,
D3l —ar YL, 7HAST—45% A/D aN—4— (L&, ADC) DHfRRexZELI-IERmEEL
TTFORIT—RIZLT]TES A, COERBEZAVTT ORI EREBED T ORILBIDBMEEREELET .

2. [FHEE

COERATIE., LTOREY—ILEFERLTWET,
[ 2-1] COERBATHEALTLSEFEY—IL

HE HH RE
1 A7 J)L® Quartus® Prime Bl = FPGA D/ \—F Oz F7ZEHFE T B=6HDY—IL T,
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(1) m10_adc_oly.7z Zf&FE#. Quartus® Prime Z#ZEIL T m10_adc oly T4LIRJ—IZ$H5D
m10_adc_oly.qpf Z7AIVERNT., THAL YL TILDTaS I/ ERBILET .

P v 4 @ m10_adc_oly >
_ &
= FFaAvh  gid E=E:T]
= £77 d analog_in_data
analog_in_data = Backup
mentor | adc_core oly inst. gsys
modelsim LC} m10_adc oly.gpf
sim = _] m10_adc_oly.gsf
) LI m10_adc_olyv
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(E 41] O ILD=ER

(2) E4-2 (X FaszorxREL-c=DEEmTHY . REMERERRTLTLET,

& Quartus Prime Standard Edition

File Edit View Project Assignments Processing Tools Window Help

(B o £ 69

Project Navigator | #% Hierarchy "Q aja = | i m10_adc_oly.v
Entity:Instance T p :
2 MAX 10: 10MOBDAFASACEG 1 //'-'.'\'.-1:41:\': . e Ve de e e ek o
> m10_adc oly ‘& % 7/’ file mil0_adc_oly.v
\ 4 // attention
| 5 // Copyright (C) 2018 MACNICA,Inc. All Rights Reserved.\n
6 i This software is licensed "AS IS".
7 // Please perform use of this software by a user's own r
8 /7 It cannot guarantee in the maker side about the damad
9 // ﬂ'lty not to use o: use tins software and a'ﬂ damage
10 HERERE RN A AR A R AN R bttt ihk e\'. kRt ud i
- . 11: Elmodlﬂe mlO_adc_01y(
< | 1|12 command_valid,
=— = 13 command_startofpacket,
Tasks Compilation "=@5 14 command_endofpacket
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(1) Tools A=—a—7\i> Options ZEIRLET

Project Assignments Processingl| Tools fwindow Help
l’-‘_'- - -~ =10 Run Simulation Tool & ’
_ ) %~ Launch Simulation Library Compiler
| #% Hierarchy "Q@ﬂ *| |3 Launch Design Space Explorer II a
2 |
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e de dr e dede e
== | |n-System Memory Content Editor
[ > | m Logic Analyzer Interface Editor
Compilation = ‘E@ & x| o1 |n-System Sources and Probes Editor
Task Signal Probe Pins...
ile Desi “ Programmer
ile Design
- — Q\ JTAG Chain Debugger
alysis & Synthesis
P ) » Fault Injection Debugger
frer (Place & Route;
System Debugging Tools Iz
sembler (Generate programming files i
jning Analysis al 1P Caalog
T —— Nios Il Software Build Tools for Eclipse
n & | Platform Designer
ettings
am Device (Open Programmer) & Tcl scripts.. _valid;
_starto|
Customize... endofp|
Options... ink_res
- clock:
I License Sefup, 1

[ 4-3) Tools *=a1—hH\> Options %:&1R

2) B 4-4 &SIz, —FETFIZHD ModelSim.. ¥T. win32aloem MNHb/SREEELET,

Category:
v General EDA Tool Options
EDA Tool Options specify the directory that contains the tool executable for each third-party EDA tool:
Fonts
Headers & Footers Setting EDA Tool Directory Containing Tool Executable
~ Internet Connectivity Precision S... | ‘E
Notifications
Synpli
Libraries ynplify | ‘E
v P Settings Synplify Pro | ‘E
IP Catalog Search Local | | s crive HDL | ‘E
Design Templates
License Setup Rivieta: FRO | ‘EI
Preferred Text Editor ModelSim | ‘D
Processing . [
Tooltip Settings _ ‘E
“ Messages ModelSim-... |C:\imEiFPGA\1 8.1\modelsim_ase\win32aloem ‘E
Colors
Fonts
~ Text Editor
Colors
Fonts
Autocomplete Text
[ use NativeLink with a Synplify/Synplify Pro node-locked license
<| > OK ‘ ‘ Cancel | | Help

(X 4-4)] EDA Tool Options [EIE : ModelSim
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Ver.18.1/Rev.l 20204 6 A 6/27 ALTIMA Company, MACNICA, Inc.


https://www.macnica.co.jp/business/semiconductor/support/contact/?product=Intel%20Programmable%20Solutions%20Group

) ALT

MA

A Macnica Division Company

(3) Assignments *—1—h\i5 Settings ZEIRLET
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File Edit View Project

Project Navigator

Processing Tools Wwindow Help
Device... | » é <
7 Settings... Ctri+Shift+E
M H _adc_olyw
@ | Assignment Editor Ctri+Shift+A sy
E|¢ Pin Planner crrl+shifteN  [==- D

[ 4-5] Assignments Hh > Settings Z3E4R

(4) 46 M&XSIZ. Category ¥HD EDA Tool Options T 4L I K)—%/NAS5ArLT. Simulation T
ModelSim-Altera # X1\ Verilog HDL Z#iRLET .

“ Settings - m10_adc_oly

Category: Device/Board...
General EDA Tool Settings
Files Specify the other EDA tools used with the Quartus Prime software to develop your project.
Libraries =
~ |P Setings EDA tools:
IP"Catalie Search Ltatians Tool Type Tool Name Format{s) Run Tool Automatically
Design Templates
v Operating Settings and Conditions Desiﬁn Entry/s... [<None> *| <None> Run this tool automati ynthesize the ¢
Voltage Simulation ModelSim-Altera - | Verilog HDL Run gate-level simulation automatically after d
Temperature —
Rl z Board-Level Timing <None>
~ Compilation Process Settings
Incremental Compilation Symbol <None>
“ |[EDATool senines Signal Integrity <None>
Design Entry/Synthesis
Simulation Boundary Scan <None>
Board-Level

[ 4-6) EDA Tool Options TEE : Simulation

(5) Category ¥&D Simulation TALJIR)—%E/NATAMT. B 47 DESITERELET

Ver.18.1 / Rev.1

” Settings - m10_adc_oly

Category:

General
Files
Libraries
v IP Settings
IP Catalog Search Locations
Design Templates
* Operating Settings and Conditions
Voltage
Temperature
~ Compilation Process Settings
Incremental Compilation
“~ EDA Tool Settings
Design Entry/synthesis
Simulation
Board-Level

Device/Board...

Specify options for generating output files for use with other EDA tools.

Tool name:IMudelSimfAlIera I v|

] Run gate-level simulation automatically after compilation

EDA Netlist Writer settings

Formart for output netlist: fverilog HDL - Time s(ale’ 1ns
Qutput directory: lsimulation/modelsim

[ Map illegal HDL characters

[ Enable glitch filtering
Options for Power Estimation

[[] generate value Change Dump (VCD) file script |Script Settings...

(X
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(1) Tools *—a—h\i5, Platform Designer Z3&IRLET,

=(g|# x
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Q\\

Run Simulation Tool
Launch Simulation Library Compiler

Launch Design Space Explorer Il
Timing Analyzer
Advisors

Chip Planner
Design Partition Planner
Netlist Viewers

Signal Tap Logic Analyzer

In-System Memory Content Editor
Logic Analyzer Interface Editor
In-System Scurces and Probes Editor
Signal Probe Pins...

Programmer

JTAG Chain Debugger

Fault Injection Debugger

System Debugging Tools

IP Catalog

Platform Designer

A, Inc
ed "A
his s
the m

this
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®
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Tcl Scripts..
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4-8) Platform Designer %3%&iR

(2) adc_core_oly inst.qsys ZZIRLEAEET,

TP DR [ miOsdooly

Fiem-

analog_in_data
Backup
db
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FADRT
E:
Pz Az
PG
l& A IR jandc care alyret ceys
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) ALTIM

ZDTH ALY T ILTIL. Core Variant T ADC control core only Z3EL TL\AI ENFERTEET,

22aL—323 % (T5ME. Enable user created expected output file % Enabled |25 . 707 T—45%
ARTEFYRIVITHLCERBREEITIFITNOTANT —8 (TXRANT7AIL) EIEETILENHY
FI,

4-10 MFITIL. Channels @ CHO %7 K£Y) User created expected output file Hh 5> analog_data_chO.txt %
BELTWVET,

|~ Core Configuration
Core Variant: ADC cortrol core only
Debug Path Digabled v

[~ Clocks

File Edit System Generate View Tools Help

— ADC Input Clock 10Me v
S Parareters 1

L] 51 | 4 Block Symeol 2 oo
System: adc core olyinst  Path: modular ade 0 B | FRefers \Valtage 7
nce signals
Modular ADEeore Intel FPGA IP =
altera. moll e . Reference Voltage Source: Exterral v
[ Gereral | | Exterral Reference Voltage: 25 V] modiiar gdc 0
- cloc response
[~ Core Configuration 1 — = \ ock_clk response_vali
Cors Varirt ADG control core ont EatogiorSimdatin reset. sin sham R -
Debug Path: Disabled v Erable user created expected outpit file: Ergbled v J st sink_reset_n tn dataf— e
adc_pl_cloc) response
[~ Clocks ic_pll_clock_clk
ADC Sarnple Rate: 1Mz v ade_pll_locked|
ADC Input Glock e —— dc_pll_locked_export ]
comman
= ommand_valid
l Voltaga ommand _channel[4..0
Reference Voltage Source: Exterral v W channz|
Exterral Reference Valtage: 25 v fEmment_snch
[+ Logic Simulation T— = altera_modular_adc
Erable user created expected output fil: | Erabled v =

T
Cranrels [0 Pressts o0 | _oo
oHo (b [ore | ore | cra| ot [ ore [ ore [ ore| ore [ crio| ehit [ criz [ cria | cria [oris [ome [ Tso|

Presets for moduiar adc 0

[~ Channel 0 ] s x
Uee Chanrel O (Dedicated analog input pin — ANAIN) Project
Slick New... ta create a presst
- — Library
[ Crannei o | o pressts for Modular ADC core Intel FPGA IP 181
User created expected output file 181 /GINKI BT /MAXT 0, ADG_oore_ oy cesign/mi o,adc,mykara\ugin,data/am\ngdata,cm ee |||[2]

User is required 1o provids expected output file using the fils browser button

[ Chanrels‘

|"OH3=_ Ht oz |ore | ore [ o6 [ore oz [ crs [cre (oo ot [oriz [oris [chia | oris [orie [ TsD
‘. Ol 10
[#] Uge Channel 0 (Dedicated aralog input pin — ANAIN)
~ Channel O Simulation

User created expected output file:

A 81 /QINKL 81 /MAXT 0_ADC_core_only design/mi O_EdG_DI{/e ralog in data/analog data_chOtxt ]

User is required to provide expected output file using the file browser button

[E 4-10] ADCIP a7 M/ A—3—EXEEIME

(4) CDINGA—A—REMNETLI=5. BIEDAETIZHS [Generate HDL] RA %)y ILET,

= I > |

. _“I_ I Generate HDL... I Finish

[® 4-11] ADCIP 27 ® HDL MDAERK
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4-2-2.ADCIP A7 DI 2aLb—3 -ETFILDER

(1) 4-12 M &ESIZ. Generation EIEAFLEILT=5. Create simulation model &H 5> Verilog Z:#3iRLT.
[ Generate] REED)VILET,

"~ Generation

Synthesis files are used to compile the system in a Quartus project.

I:] Create timing and resource estimates for third—party EDA synthesis tools.

[
|
i Create HDL design files for synthesis: verilog v
i
' Create block symbol file (bsf)

| |~ Simulation

The simulation model contains gererated HDL files for the simulator, and may include simulatioronly features.
Simulation scripts for this comporent will ke gererated in a vendor—specific sub—directory in the specified output directory.
Follow the guidance in the gererated simulation scripts about how to structure your design's simulation scripts and how to use the

ip—setup—simulation and jp—make—simscript command-line utilities to compile all of the files needed for simulating all of the IP in
your design.

Create simulation model: I Verilog v I

|
|
!
|
i |~ Output Directory
|
|
|
|
\

Path: [ JA81/QWKIBI/MAXI O ADC_core only design/mi O.adc oly/adc_ core olyirst] [ ..

Gererate Cancel

(& 4-12] $2al—2a - FETIVELERT D ADRE

(2) 4-13 DESIZRRENT=5, [Close] RELED)VILET .

~ Save System Completed

ple oo

@ Irfo; C:/intelfpgasip/Aee/% watched O files in 000 s=cords -~
@ Info: Reading index C:¥intelfpga¥1 8.1 ¥quartus¥sopc_builder¥builtin.ipx
@ Info: C-¥intelfpga¥1 8.1 ¥gquart us¥sopc_builder¥builtin.ipx described 83 §
@ Info; C/intelfpgas18.1 /guartus/sopc_builder/ ek % atched 8 files inC
@ Info: Reading index C:¥intelfpga¥1 8.1 ¥quartus¥common¥librarian¥factc
@ Info; C-¥intelfpga¥18.1 ¥guartus¥common¥librarian¥factories¥index.i
@ Info: C:/intelfpgas18.1 /quartus/common/librarian/factories/ 5/%
@ Info: C:/intelfpgas18.1 /quartus/sopc_builder/bin/$IP_IPX PATH mat =
@ Info: C-¥intelfpga¥1 8.1 ¥guartus¥sopc _builder¥bin¥root_components.if
© Info: C:/intelfpga/18.1 /quartus/sopc_builder/bin/root_components.if
% 1] >

&) Save Syetern completed successfilly

Clo

(H 4-13] RELEABMNERICRESNIIGEDRTEE

s —— |
Ver.18.1/Rev.l 20204 6 A 10/27 ALTIMA Company, MACNICA, Inc.


https://www.macnica.co.jp/business/semiconductor/support/contact/?product=Intel%20Programmable%20Solutions%20Group

A2 T)L® MAX® 10 ADC ZfEALT=>2al—a>FIE [ADC control core only #i)
M ALTIMA

(3) 4-14 DESIZFRSNT=5, [Close] RELED)vILET,

- Generate Completed

i@ o

@ Progress: Building conrections -
@ Progress: Parameterizing conrections

@ Progress Validating

@ Progress: Dore reading input file

@ Info: adc_core_oly inst: Gererating adc_core oly inst “adc_core oly inst
@ Info: modular_adc O “adc_core_oly inst” irstantiated altera_modular_ad
@ Info: control intermal: “modular adc 07 iretartiated altera_modular adc
@ Info: adc_core_oly inst: Dore “adc_core_oly inst” with 3 modules, 9 files
@ Info: geve—mererste succeeded.

i Info: Finished: _l:”}‘r.'eate HOL design files for synthesis

4 mn »

<fm

) Gererate: completed successfully

[ 4-14] S 2aL—23 - FETIILAERICEFSN-IEE DR TEE

(4) 4-15 MEKSIZ, File *=—2—h\i> Exit Z3ERT BH . £LLIZL. Generation BEIEHATD [ Finish] "2
=)y oLET,

- |IP Parameter Editor - adc_core_oly inst.qsys

_Edit System Generate View Tools Help

New System... Ctri+N
New Component...

Open... Ctrl+0

Save Cl+s —
Save As... L
Refresh System F5 L
Export System as Platform Designer script {.tcl) y

Export System as hw.icl Component
Browse Project Directory...

Recent Projects

Feference Voltase Source: i i |

[X 4-15) IP Parameter Editor EIEIDIR T (FD 1)

s —— |
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(5) 4-16 DESHEEHEEEILT=5. [Cose] RAEI)VILET,

Integration with Quartus Software

The following rew files were created:

C¥work¥ko..C_core_only designy ¥mi 0 adc oh¥adc core oly inst.csys

To edit or modify a .gsys file in your design, do ore of the following in the Quartus
software main window:

= Open the .ceys file with the Open command on the File menu

— Double—click the .gsys file on the Files tab in the Project Navigator
— Open Platform Desigrer from the Tools menu

= Use the geys—edit command at the command line

To gererate HOL files from a .gsys file, do ore of the following in the Quartus software:

— Open Platform Desigrer from the Tools menu

= Use the gevs—edit command at the command line

= Open Platform Desigrer from the Quartus software and click on the ‘Gererate HDL..” button

[ Do ot show this message again

[ 4-16]) IP Parameter Editor EJEINFZT (F® 2)

(6) 4-17 DESHEEHEEILI=S, [0K] REIVED)VILET,

& Quartus Prime

,_0. You have created an IP Variation in the file
Ly C:fwork/ /m10_adc_oly/adc_core_oly_instgsys.

To add this IP to your Quartus project, you must manually add the .gip and .sip files after generating the IP
core.

The .qip will be located in <generation_directory>/synthesis/adc_core oly_instqip

The .sip will be located in <generation_directory>/simulation/adc_core_oly_instsip

o |

(& 4-17]) qip F7AILE sip T7AILDER

s —— |
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4-2-3. SHEBEBZEITOADERIRE
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DI7AILE org ml0 adc olyvt [TEBLTULVET,
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4-4. Nativelink DERTE

COEBEHTIZK.IP A7DI3IaL—av({EFIE Nativelink Z{EHELT ADCIP A7 NI 3IaL—av%k
TWET, LIIE., Z0AICBELEREERBNLET,

(1) Assignments *—1—h\> Settings Z3EIRLET

uartus Prime Standard Edition

|| Processing Tools Window Help

Edit View Project

Er ¢ Device.. 7 é
’ ¢ Settings.. Ctri+Shift+E

[ Navigator s H _adc_oly

& Assignment Editor Cul+shift+A  |__ -
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[ 4-26] Assignments A—1—h\i5> Settings DFER

(2) Category 80 EDA Tool Settings T AL 7)) —Mm 5 simulation Z/\AZ5AR_ES , Compile test bench &
DEIZHS [ Test Benches] RALED)vILET,

Category: Device/Board...

General  simgtation |
Files Specify options for generating output files for use with other EDA tools.
Libraries

~ IP Settings Tool name: ‘MGdelSim—Altera %

IP Catalog Search Locations
Design Templates
* Operating Settings and Conditions

[ run gate-level simulation automartically after compilation

EDA Netlist Writer settings

Voltage
Temperature Format for output netlist: |Verilog HDL 0 Time scale: |1 ns i
* Compilation Process Settings Output directory: |simulationfmodelsim "II
Incremental CDmEilation
I Map illegal HDL characters [] Enable glitch filtering

~ EDA Tool Settings

Board-Level

Options for Power Estimation

[] Generate value Change Dump (VCD) file script |Script Settings...

* Compiler Settings Design instance name:

VHDL Input
Verilog HDL Input
Defalile Paramieters ‘Mcre EDA Netlist Writer Sertings...|
Timing Analyzer NativeLink settings
Assembler -
Design Assistant & Jionc T
Signal Tap Logic Analyzer (@) Compile test bench: |m10_adc_oly_vig tst 'I Test Benches_..||

Logic Analyzer Interface
Power Analyzer Settings [ use script to set up simulation:

SSN Analyzer () script to compile test bench:

‘MBFE NativeLink Settings...

<] 1> \ oK | | cancel | Apply
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Ver.18.1/Rev.l 20204 6 A 18/27 ALTIMA Company, MACNICA, Inc.



https://www.macnica.co.jp/business/semiconductor/support/contact/?product=Intel%20Programmable%20Solutions%20Group

AT IL® MAX® 10 ADC Z{FERALT=S =2l —3a>FIE [ADC control core only #&)
M ALTIMA

(3) 4-28 M &S%; Test Benches EEHFEEIL1=5 . Existing test bench settings ¥D P TRRSNDAZ1—%
INZARLT, [Edit] REVED)VILET,

Specify settings for each test bench.

Existing test bench settings: New...
= |
Name Level ModL esign Instanc __ Run For Test Bench File(s

Delete

| OK || Cancel || Help

(& 4-28) Nativelink DEEFE: TAMUFDIEE (FD 2)

(4) 4-29 M&KS7%: Edit Test Bench Settings EIEHEEELT=5. Test bench name [T AR FDIYTED
—IJLE. KU Top level module in test bench (T AU FDIT7A IV BDERESNTLEINEHERLET,

Test bench name :
TFAMUFDIYTED2—)LE ml0_adc oly vig_tst ZHETE
Top level module in test bench :

TAMUFDI7AILE m10_adc oly ZIEFE

(5) Z7AILBIX. K 4-29 DETIZHS File Name HEDHFTELRTEINET,
® SEEARTZEHERINI=TRAMUFDGE., 771IVEE M TED1—ILBITERLEYFET,

— oo
Edit test bench settings for the selected test bench. TZ FA/a:

Test bench name: m10_adc_oly_vlg_tst | = = -
[ $

[ m10_adc_oly.vt
Top level module in test bench: (m10_adc_oly vlg_tst a0y

[[] use test bench 10 perform VHDL timing simulation

Design instance name in test bench: |[NA

Simulation period

29 // constants
30 // general purpose registers
31 reg eachvec;

32 /I test vector w'pput registers

(®) Run simulation until all vector stimuli are used

) End simulation at: s

Test bench and simulation files

File name: ‘g Add

File Name Library HDL Version Remove

simulation/modelsim/m10_adc_olyvt I
)

Properties..

OK H Cancel H Help
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[ Run Simulation Tool »¥ pTL Simulation “ ﬁ ii E
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Vi

pil_Jocked
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(3) 4-32 M &SI, response_data & adc_data Z/\ATARL T, BV YIHS Radix %iEIR% . Hexadicimal
#ERLET,

F

command_valid
4 pll_locked
4 reset_sink_reset_n
4 command_ready .
response_channel 00000 | | Ufixed
; + Use Global Setting

Show Base

Numeric Enums

Symbolic Enums

1 float32
2 floats4

[E 4-32] 16 #EHFT GEERD

(4) COFREHMSEBICITONGE. EERIE B 433 OESBERTRICUVEHDYET,

comma

pl_loded
reset sink reset n
command_ready
response_channel

response_endofpacket
response_startofpacket
response_valid

MNow | 165916900 ns |
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(5) TAMT—%4 analog_data_ch0.txt TEeAHAATZNAEIL. response_data [CRMEINFET,

SEABBLETAMUF T, REMICBELOTVOESIZ, B 434 OL57%ERRZEMLT, adc_data
LIZBEWGE TR T EME TESLIITHELTLET,

™ = i T
46 wire response_startofpacket;

47 wire response_valid;

48

49 // Monitor

50 wire [11:0] adc_data;

51

52 // assign_statements (if any)

53 @Amlo0_adc_oly i1 (

54 // port map - connection between master ports and signals/registers
55 .adc_pll_clock(adc_pll_clock),

56 .clk(clk),

57 .command_channel (command_channel),

58 .command_endofpacket (command_endofpacket),

59 .command_ready(command_ready) ,

60 .command_startofpacket (command startofpacket),

61 .command_valid(command_valid),

62 .pl1_Tocked(p11_locked),

63 .reset_sink_reset_n(reset_sink_reset_n),

64 .response_channel (response_channel),

65 .response_data(response_data),

66 .response_endofpacket(response_endofpacket),

67 .response_startofpacket(response_startofpacket),
68 .response_valid(response_valid)

69 3%

70 =

i b // Monitor

72 assign adc_data = (response_valid != 1'b1)? adc_data: response_data;
73

74 initial

75 Obegin

61 code that evecitec only once

[ 4-34] E=A2—F®DIES adc_data DB

(6) 4-35 TRIOYLKREEI(L. response_data Tl response valid /X Hi DESHEITTORILERT—4
002 #RRLTULDEMIZHL T, adc_data TIE response valid A% Hi H5 Low 2T 7H—LTET—
A 002 DRTHIHFTEL TSI EEFRLTULET,

Cursor 1 136500 ns | S e 1 s I
i Il J | Sl

[K 4-35] E=42—HAD{ES adc_data D IaL—iav ik

UET, 2ab—2a0 DEFIRITERTTY .
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5. HLEETELEDESYH -- Appendix 1 -

ZDETIL. Appendix ELT ModelSim MEHLTRRLI-TOZILT—2ITMA . Yl L TEHEL-ERIE
FLET DFEREL T 16 EHT —FTHET D AxE. TOVNER TRENICLEE T 2555 BNLET,
WM EICKDEREDEHICIE, b Appendix 2 TRENTARIAE —MEEALET,

5-1. 16 EHT—ATLET DHE
(1) 5-1 M 2aLb—2a KRS TIE., adc_data EDEET—2EKEBIZNATALTULVET,
® 16 EHRTITHHEIT. COEBHD M45. O3aL—3>DETI 2SBLTESLY,

58| Wave - Default + ) x|

&) wp adc_data

2 [ ] T I — 17
5879233600 ns
136500 ns 135500 ns

| Kl 2] i [T O]

[ 5-1] E=2—FDES adc_data D IaL— 3V ER (LEEBHRELR)

® dc_data (&, BRGET—HZITEMELIZESTHY ., RRSNT= 16 EHDIEIL. ModelSim AFEHL
=ERIETY

() 52 DEAIE, FHRRDRIAFE L —FCERL-EREEZAL TR RLTOVET . E 51 TKEIZNAS
ATz 16 EHT—2IE. B 5-2 TKEBIZNASARLT- 16 EHOT—RELEKTHE MEIT—ELT
WBA. V3L — a RN EHEEOBRENRN TOAIENEETEET,

;‘ B Y3aL—2av ANT—448 Sin ROBREDSE = ERIEE =& | [ar ] [ en@Ee | menmse |
:‘ ==l [ ST i)
B YIPLUIADRE i e [l [ T | Eal—isa 17— 3iil
; Ea = siss | SR E — “ | ALETREDIE = 5L
o m o 1 0x000
[ — ] e : | oo
- AZL e T 3 0x002
7 ; . 4 0x003
e : 5 0x005
o oome | ¢ i 0008
: [l e 1 8 0x00f
R - ’ 9 0014
- = 10 0x019
1 0501
12 0x026
13 0x02¢
14 0034
15 0x03d
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5-2. 7AYNER CREMICHET 5%
(1) 5-3 M&IIT, response_data & adc_data Z/\ATAFLT, BV M5 Radix %FEIR#E. Unsigned

EERLES,

w ; Global Signal Radix..,
:Taj : Symbolic
Binary
Combine Signals... Octal
Group... ‘ mal
|_:ﬂg|'D'J!_,\ v =

Hexadeamal
ASCII

Time

Sfixed

Ufixed

Use Global Setting

Force...
MNoForce
Clock...

Show Base

Numeric Enums

Symbolic Enums

3122795300 ns

C - L L

[E 5-3] Unsigned %3&iR

(2) 54 M&IIZ. response_data HKXU adc_data H', FELLEBH TR RSN TSI EEHERLET,

4 reset_sink_reset_n

4 command_ready
-4 response_channel
& response_data

15000ns ||

[ 5-4] FELLEKIZKERTER
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(3) adc_data Z/\ASAFLT. HEY')vIh5 Format ZI8FEL T. Analog (automatic) ZERLET .

pll_locked Combine Signals...

reset_sink_reset_n Group...
command_ready Sro)
£ response_channel
f-* response_data
4 response_sndofpacket
4 response_startofpacket

4 reenancs ualid

Curenr 1

[ 5-5] Format Z}§E L T. Analog (automatic) %E&iR

@) LoPHERABRINIE K 56 OLIFFOTKESA VIR RER/EHICTEIENTEET,

15000 ns

(R 5-6] 70T EMIAVERERT

(5) 5-7 M&SIZ, Appendix 2 THER G HREIAEL—FTHLISTRTHARELGD T, B 56 DRMBRER
BRI T HTECEoT, YRal—LaviREN LHELD  BEFALGEAUNBETEET,

-
[Tiar—avitihs 20Em |
[ ADZEBBEOEGOL) |
1 0x000
2 0x000
3 0x002 P
4 0x003 VIN (& R
5 0x005 3.000000
6 0x008
7 0x00b 2500000
8 0x00f] 2.000000
9 0x014 i
10 0x019 ‘@ 1500000
11 0x01] —
12 0x026
13 0x02c 0.500000
14 0x034 P——
15 0x03d . - -
R E RIS SR b 4

16 05046 SENR8YYREERR8A53888¢88¢8¢
17 0x04] S
18 0x05a
19 0x064
20 0x06f]

[ 5-7] Appendix2 DRETES—FTTITRRLIZER
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22al—L3rY—)L ModelSim AMT540IE
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SIM_FILE_CHO Observed Simulator Qutput A
Sequence pattern: Voltage values (Hexadecimal) ‘.
1 CHO, CHO, CHO... e l:
F%m * i ?? V_”'lel gx?;: Simulation l||
S g8 Y 2 i X " 1 s
T+ —Y g g Vies ousrs | tmeflow ‘. EeE
A ! 15 e (K148 <o |
T Ver =25V 01333 >
": - - ®
R : N
TANT—% 5 4
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) TPANT—RADOEL (EiR{E)
D ROFERITESNT, 7HOI T—ENST ORI T—4% 16 EHTEH
& (VIN/VREF ) *2 ( 9f#EE ) CZDEE. VREF=25[V]. HfFRE =12 [bits]
Q FEERRRA T aLAE
B) ANT—HATLav
@ EEAN:  BAOTFOUT—SEEEAN
@ EBAA:  TFOITFANENMES. AR CHBERLI-T— 4%
@ BREAKN: Sin BOBRKESNELT. ANT—RELTRHIATEE, 3 D0 Sin KETERARE

O LITO#EEICIERELTLER A
1. REtVY—
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3. VWILFFYRIL
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#ASHTI=—H FEEHFE BHVOADEIF—L
4. FERTRYHR-STVDEE, Hiff. 7TOJSLICELTGERALEEROEZEIOVTR, ERZAVNRETOTHLNLHIT T RIS,

5. AEHBHRKEFATIROBBMLERTT BEETHEAITEIRE, ZFA—DRETOEBROEHIHHE TIHALESL,

e —— |
Ver.18.1/Rev.l 20204 6 A 27/27 ALTIMA Company, MACNICA, Inc.


https://www.macnica.co.jp/business/semiconductor/support/contact/?product=Intel%20Programmable%20Solutions%20Group

	インテル® MAX® 10 ADC を使用したシミュレーション手順 【ADC control core only 編】
	目次
	本書をお読みになる前に
	1. はじめに
	2. 使用環境
	3. このサンプルを利用する利点
	4. シミュレーションの操作手順
	4-1. プロジェクトの起動およびシミュレーションを行う為の事前設定
	4-1-1. プロジェクトの起動
	4-1-2. シミュレーションを行う為の事前設定

	4-2. シミュレーション・デザインの構築
	4-2-1. ADC IP コアのパラメーター設定
	4-2-2. ADC IP コアのシミュレーション・モデルの生成
	4-2-3. 論理合成を行う為の事前設定
	4-2-4. 論理合成

	4-3. テストベンチの生成およびカスタマイズ
	4-3-1. テストベンチの自動生成
	4-3-2. テストベンチの入れ替え
	4-3-3. テストデータの入れ替え

	4-4. NativeLink の設定
	4-5. シミュレーションの実行

	5. 机上計算との整合性 -- Appendix 1 --
	5-1. 16 進数データで比較する方法
	5-2. プロット波形で視覚的に比較する方法

	6. 付属の表計算シートについて -- Appendix 2 --
	改版履歴


